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Five Step Process to Simulation Analysis 
The methodology for analyzing a process with simulation includes these 5 basic steps: 
 
1. Identify Goals, objectives, and scope for the project.  This is the most important step. 
2. Gather Data on the existing process through interviews and measurements. 
3. Build a Model of the current process, which, when simulated, approximates the process performance. 
4. Perform Simulation “what-if?” Analysis by making changes to the model, and running simulations. 
5. Present your Results and recommendations for potential changes to the current process. 
 
These 5 basic steps are shown in Diagram 1.0: 
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Diagram 1.0 

 
The purpose of this document is to provide a guideline for using iGrafx simulation client applications, such as 
iGrafx® Process or iGrafx Process for Six Sigma, to build and simulate a process model (Step 3). It is not an 
exhaustive review of features, but a general guideline for quickly building a process model and simulating.   

Step #3: Build a Process Model 
Using iGrafx Process to build a process model involves four basic activities, shown in Diagram 1.1 (Below): 
 
A. Create the Process Diagram by using departments, shapes, and connection lines. 
B. Describe the Behavior of Each Activity (such as time duration) through the Properties dialog box. 
C. Describe the Simulation Environment the process lives in by using the Scenario. 
D. Execute a Simulation and analyze the results in the Report. 
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A. Create a Process Diagram (Map or Flowchart) 
The Process diagram type supports all the features and functionality discussed in this guide.  When the tool 
presents the QuickStart dialog box, choose a template category such as Process and a template such as Cross-
Functional Process. 

The Selector cursor: Click the left mouse button to select an object. 

Placement cursor: Click, or press-hold-drag-release, the left mouse button to place a shape/symbol. 
 

 Departments: 
• Click the “Departments” icon in the Toolbox toolbar (the vertical toolbar on the left side of the window) 
• Choose Insert Department, which opens the Insert Department dialog box.   
• Enter a name for the department, and Click OK. You may also click the Apply button and add more 

departments.  
 

 Add a Shape/Symbol: 
• Click on a Shape icon in the Toolbox toolbar. 
• Move the cursor into the process window. The cursor changes to the placement cursor (a pencil and shape). 
• Press, drag, and release the left mouse button to place the shape on the diagram. 
• Start typing to enter text.  The text will be placed in the shape automatically. 
 

 Connect Shapes/Symbols:  
• Move the Selector tool’s arrow cursor (or connector line tool’s line cursor) inside the source, or origin, shape. 
• Press and hold the left mouse button. 
• Drag the cursor to destination shape. The cursor automatically changes to the line cursor (pencil and line).   
• Position the cursor inside the destination shape, & release the mouse button; the line is automatically routed. 
 

 Enter or Modify Text in a Shape, or on the Process Diagram: 
• Select the shape, if it isn’t already selected. Or click the “A” on the toolbox toolbar, and click in the diagram. 
• Type the text. Press the Esc (Escape) key when you are done typing. 
 

 Display Shape/Activity Numbers: 
When a shape is placed on the diagram, a number is automatically assigned to the shape. By default the activity 
numbers are not displayed. To display activity numbers on the shapes:  
• Click on the Shape Numbering button in the Toolbox toolbar, and choose Show All Shape Numbers.  
To automatically renumber the shapes:  
• Click on the Shape Numbering button in the Toolbox toolbar, and choose Auto Renumber, then click OK. 
 
Please see the FlowCharter Quick Reference Guide for more information about diagramming with iGrafx. 

B. Describe the Behavior of Each Shape/Activity 
Most shapes represent activities, and will contain behavioral information. As a general rule, during simulation a 
transaction enters the activity and visits each page of the Modeling category in the Properties dialog box starting 
with Inputs, and proceeding down through the Last Simulation page. The Process Guide (the Process page in the 
Guide category) allows quick entry of common data. Commonly used Modeling category pages are Inputs, 
Resources, Task, and Outputs.   
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Display the Properties Dialog box 
 
Double-click the left mouse button on a shape, or click the right mouse button and choose Properties. 

            
Diagram 2.0: Inputs            Diagram 2.1: Resources 

 

        
Diagram 2.2: Task            Diagram 2.3: Outputs 

 
Inputs page: The Inputs page allows for the collection of transactions (see Diagram 2.0, above). The default is 
no collection. The most common forms of collection that are used in modeling: 
Batch:  Collect multiple transactions in a basket and carry them through the process. The On Completion tab of 

the Task page contains a command to Unbatch the transactions, emptying the basket.   
Join:  Merge multiple transactions together into a single transaction. Some data is merged, including attributes. 
Gate:  Hold transactions at the gate until a condition is met and the gate is opened. 
Group: Transactions can enter an activity individually, and they are tagged with a group name. 
 
Introduce Transactions: Defines a point in the process where transactions are introduced. Choose None to specify 
that no transactions are generated here. Choose Using a Start Point to name the start point and then set up 
generators to introduce transactions into the activity. Choose Generate Here to specify that the simulator will 
generate a transaction when a condition occurs; such as an event happens, a period of time elapses. 
 
Resources page: The Resources page identifies the resources required to do work in the activity (see Diagram 
2.1, above). iGrafx has a built-in resource named Worker.  The Worker resource belongs to each department.  
When a department is added to the Process diagram, a worker is automatically created and allocated to the 
department. Creating other Labor or Equipment (non-worker) resources is done in the Scenario (see C. Describe 
the Process Environment in the Scenario). 
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Many options may be specified for a resource; however, the following are the most important: 
• Choose the resource by type using the scroll down menu (The Default is Worker unless you change this). 
• Specify the count (number) of resources required to work on each transaction processed. The default is 1. 
• Specify how the resource is acquired. Usually the resource works for the activity, which is the default.  
 
To specify that more than one type of resource is required for an activity, click the Add button in the Resource 
page. To remove a specified resource from participating in an activity, choose the Delete button.  
 
Task page:  The Task page defines the type of task the activity performs (see Diagram 2.2, above). The Step tab 
is used on most activities. The Task page defines the type of task, duration, special handling, etc. 
 
Types of Tasks: There are three types of tasks.  
Work: This task will use a resource to work on a transaction for the duration of the Task. Reported as Work. 
Process:  This task is linked to a subprocess. During simulation, the transaction will move from this activity to a 

start activity on another diagram (subprocess). The transaction returns to this activity when it completes 
the subprocess. To create a subprocess: 

1. Choose Process from the drop-down menu for task type (subprocess is chosen automatically). 
2. Click on the New Process button. 
3. Enter a name for the process, and click OK. 

To view a subprocess, hold down the Shift key and double-click. You may also right-click and choose 
the name of the subprocess to follow the link. The times in the subprocess will be collected in the report. 

Delay: This task blocks the transaction for the duration of the Task. Delay tasks do not usually use a resource.   
 

Duration: If the activity is Work or Delay, then task will have duration; default is zero (0). The duration may be: 
Constant:  The same (constant) duration value for all transactions. 
Distributed:  The duration value will range between a minimum and maximum value. The duration may be 

uniformly or normally distributed between the two numbers: 
• Uniform specifies every number between the two numbers has an equal probability of being used. 
• Normal specifies a normal (bell curve) distribution, which is centered between the two numbers. 

Expression: Equations may be defined to describe the duration of the activity. For details on building 
expressions, search the software Help system (Help menu) using keyword “duration expressions”. 

 
Value Class: Is an opportunity to classify the activity. The implied meanings are: 
VA:  Value-Added. The customer is willing to pay us for this work; it adds value to the end product. 
NVA:  No Value-Added. This work adds no value. Lean methodology refers to this as muda. 
BVA:  Business Value-Added. This work is necessary for the business, but does not add value for the customer. 
 
Task Capacity, Schedule, and Overtime Behavior: Defines limits to the number of transactions processed and the 
processing timeframe. Also defines activity behavior with regard to the defined schedule. 
Limited Capacity: Limits the number of transactions that can be processed at one time. 
Limited Schedule: Specifies whether the task duration of the activity is limited to a schedule. Resource 

schedules still apply for any resources required for the activity. 
Overtime Behavior: Specifies how the activity behaves if resources go out of schedule. 
 
On Completion: This tab of the Task page has functionality to complete transaction handling. Common choices: 
None:   No special task ‘on completion’ behavior is defined. This is the default. 
Duplicate:   Copies a transaction into multiple (count) identical transactions. 
Discard:   Terminates the transaction. The transaction will not be counted in the simulation report. 
Unbatch: This undoes the “Batch” collection (see the Inputs page for information on Batch). 
 
Outputs page: The Outputs page describes how transactions leave the activity (see Diagram 2.3, above). A 
transaction will follow directed a connection line or lines to the Input of an activity. The Normal tab is used on most 
activities. The Normal tab defines how transactions follow lines, and Exceptions specifies any special outputs. 
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Normal Tab: Specifies which of the lines the transaction will follow to an activity. The common choices are:   
All:  This sends the transaction down all paths that leave the activity. This is the default. If 

there is more than one path, an implicit duplication occurs, creating identical transactions 
to be sent down each path. 

Decision: This sends the transaction into one of the paths specified, based on percentages or 
expressions. 

 
Exceptions Tab: Define conditions where the activity terminates early, and the path to take. Common choices: 
None: This is the default choice; no special exception will occur. 
Timer: Sets a time limit on performing the activity; follow the exception path if the limit is reached. 

The Timer may be disabled at various points in the execution of the activity. 
 
Attributes page: Allows access to attributes, which are similar to programming variables and are used to 
communicate information and manage the flow of transactions through a process. For details on attributes, search 
the Help system using the keyword “attributes”. 
 
Last Simulation page: The Last Simulation page summarizes statistics for the activity from the last simulation. 

C. Describe the Process Environment in the Scenario 
A Scenario describes the simulation environment for the process. A single file may contain multiple Scenarios.  
 

 View the Scenario: You may view information in the Scenario “at a glance” in the Scenario window. To open 
the Scenario window, click the View Scenario button in the Modeling toolbar. Alternately, use the File menu and 
choose Components, and in the Components dialog, double-click the Scenario or right-click and choose View. 
 
The first four topics in the Scenario are the most important in getting started. Those topics are Run Setup, 
Generators, Resources, and the Schedules sub-topic under the Calendars topic. 
 

      
Diagram 4.0:          Diagram 4.1:                   
Run Setup       Generators              
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Diagram 4.2:                   Diagram 4.3: 
Resources                  Schedules 
 

 Run Setup:  The Run Setup topic sets simulation timing and how the results of simulation are placed in a 
report. Double-click on the Run Setup information in the Scenario to invoke the Run Setup Dialog (see Diagram 
4.0, above).  Of the many options you can specify, the most important are: 
 
Simulation Time tab:  
• Simulation Start: Specify when the simulation starts (default is a Weekday vs. by a specific Date).  
• Simulation End: The default is Transactions Complete.  Most often you’ll want to specify a specific duration for 

simulation (Custom).  To specify a custom end for simulation: 
o Choose Custom from the Simulation End scroll down menu. 
o Choose a duration time unit (Hours, Days, Months, etc.) 
o Enter a duration (simulation end) value. 

 
Initialization/Reports tab: Specify how the simulation results are to be saved to the report (default is Create). 
 

 Generators: During simulation, generators introduce transactions into the process. Of the many options you 
can specify, the most important is Generator Type. The generator type determines other data to specify. Common 
types of Generators are: 
Completion: The Completion generator introduces transaction(s) into the process when the previous transaction(s) 

has completed processing. It will place one transaction at a time, or a group of transactions, in the 
process until it (they) reaches the Maximum count. The default is a Max count of 1. 

Demand:  The Demand generator introduces a transaction whenever the named resource (for example, Worker) 
is available, in the department that has the Start activity for this generator. 

Interarrival:  The Interarrival generator specifies the duration of time between transactions arriving in the process.  
There are many options; you may want to start with a simple Constant or Distributed interarrival time.  
• Constant: The same (constant) time between transactions entering the process.  
• Distributed: The time between transactions entering the process will range between two values.   
• Expression: The expression can use math functions, such as ExponDist() for exponential arrivals. 

Timetable:  The Timetable generator introduces transactions at specified intervals, over a span of time. The table 
may be repeated. To modify the timetable generator, click the Modify Timetable button, and a bar 
chart appears. The X-axis shows the time intervals and the overall time span, and the Y-axis shows 
the number of transactions introduced during each interval.  The values of interest are:   
• Total Span. The total span of time covered by the timetable pattern given. For example, 1d (1 

day) indicates that every day the given pattern should repeat. 
• Time Resolution. The smallest interval of time in the bar chart. 

 

 Resources: The Resource topic is where resources used by the process are created, modified, and managed. 
Double-click the left mouse button on the Resources topic/data in the Scenario to obtain the Resources dialog box 
(see Diagram 4.2, above).   
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To add a resource, click the Add button, which adds a new type of resource (other than Worker).  
• Enter a name under Resource Name. You cannot use spaces in the name. 
• Choose a Resource Classification; we recommend Labor or Equipment, as Other has limited use. 
 
To modify a resource, select the resource in Existing Resources list.  
• Resource Count: Enter the number of that resource available to the process. 
• Schedule: Choose the schedule that indicates when the resources are available and inactive (see below). 
• Resource Cost: Specify the hourly pay rate, and/or hourly rate in overtime, for the resource. 
 

 Schedules:  Schedules are spans of time. The time will be either active or inactive. You can use any of 
several built-in schedules (see Diagram 4.3, above). The default schedule is the Standard schedule, which is 
Monday through Friday, 8 AM to 5 PM, with 1 inactive hour for lunch. For details on creating and modifying 
schedules, search the software Help system using the keyword “schedules”. 

D. Execute Simulation and Analyze Results in the Report 

 or  Run a Simulation: To run a simulation, from the Model menu, choose Run and then Start. You can 
“trace” simulation by first entering Trace mode, and then running simulation. The Control menu’s Trace Colors 
command shows the colors’ meanings. When simulation is complete, a Report is presented for review. 
 
Report Structure: The first four of the Report tabs contain sets of commonly used statistics captured during 
simulation: Time, Cost, Resource, and Queue (Waiting in Line) information. The fifth tab, Custom, is blank; you 
may add a report element (table or graph) to the Custom tab by copying and pasting an existing report element, or 
creating a new report element from the Report menu. 
 
Report Results:  Basic statistics are gathered about process times, costs, resources, and waiting lines or queues. 
You may also create your own custom statistics. The basic statistics are categorized depending on whether they 
apply to transactions, resources, or activities (see Table 5.0, below).  
 

Transaction Resource Activity 
Process Performance From the 

Transaction’s Perspective 
Process Performance From the 

Resource’s Perspective 
Detailed Information About What 

Occurred At Each Activity 
Completion Count Number of Workers (Count) Cycle Time (Avg.) 
Cycle Time (Avg.) Utilization (Util. %) Work Time (Avg.) 
Work Time (Avg.) Busy Time (Avg.) Wait Time (Avg.) 
Wait Time (Avg.) Idle Time (Avg.) Costs (VA, NVA, BVA) 

Resource Wait Time (Avg.) Out Of Service Time (OOS) # Trans. Wait (Tavg, Tot., Max) 

Blocked Time (Avg.) Inactive Time (Avg.) # Trans. at Activity (Tavg, Max) 

Inactive Time (Avg.) Overtime (OT) # Transactions 

Service Time (Avg.) Costs (Tot., Std., OT, Busy)  

Costs (VA, NVA, Labor, Equip.)   

 
Table 5.0 Some Common Default Report Statistics 
 
Note that placing your cursor over a statistic heading in the report will produce a yellow tooltip that explains the 
statistic in more detail. The tooltip will not, however, explain summarizations like Min, Max, Average, Total, etc. 
 
Basic Transaction & Activity Time Statistics:  The 4 basic time statistics are:  
• Work Time:  The time accumulated doing work (Task page Duration). 
• Resource Wait Time:  The time accumulated waiting to obtain a resource (Resources page). 
• Blocked Time:  The time accumulated waiting in collection (Inputs page) and in delay (Task page). 
• Inactive Time:  The time accumulated waiting for a resource that is inactive or out of schedule. 
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Composite Transaction & Activity Time Statistics: The 4 statistics constructed from the basic statistics are:   
• Cycle Time:  Blocked Time + Resource Wait Time + Inactive Time + Work Time 
• Service Time:  Blocked Time + Resource Wait Time + Work Time 
• Wait Time:  Blocked Time + Resource Wait Time + Inactive Time 
• Service Wait Time:  Blocked Time + Resource Wait Time 
 
Basic Resource Time Statistics: The 4 basic resource time statistics are: 
• Busy Time:  The time the resource is acquired; e.g. active & working (Task page Duration). Paid. 
• Idle Time: The time the resource is active & in schedule, but not busy. Also paid time. 
• Out Of Service (OOS): The time the resource is scheduled to be active & also unavailable. Paid or unpaid. 
• Inactive Time: The remaining time when the resource is not scheduled to be available or OOS. 
 
Add a New Report Element: 
• From the Report menu, choose Add Element. 
• Follow the Wizard to Define the Statistic category, Structure, Filtering, and Format of the Report Element. 
 
Turn a Tabular Report Element Into a Graph: 
• Double-click on the Report Element to obtain the Edit Report Element dialog box. 
• Choose the Format tab. 
• From the “Display As” scroll down menu, choose Graph. 
• Choose the style of graph you wish to display; for example, a 2D bar chart. 
• Click OK. 
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Name a Simulation Run:  

1. From the Report menu, choose Simulation Data. 
2. Double-click the simulation run you want to name. 
3. Type in the new name and click OK. 

 
Copying (Exporting) Report Data to Other Applications:  

1. Click on the report element to select it. You may select more than one element by using your shift key. 
2. Press Ctrl+C to copy, right-click and choose copy. Make the other application active, and paste with 

Ctrl+V; or from the Edit menu, choose Paste, or Paste Special if available. 
 
 
For more information on iGrafx Training and Consulting services, please use the following contact information: 
Email: info@iGrafx.com  Phone: 503-404-6050  Fax: 503-691-2451   
Mail: 7585 SW Mohawk Street; Tualatin, Oregon 97062 


